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Getting Started Guide

How do I add a plot? 
  You can drag and drop any BAM, BED, IDF, TSF or VCF fi le 

directly into the Plot View. Additionally, if a BED or VCF 
fi le is bgzipped you can drag and drop the BED.GZ or VCF.
GZ fi le into the Plot View as well. GenomeBrowse also 
supports many other fi le formats.

  You can also stream BAM and TSF fi les by clicking 
on the Add button  (             ) in the top-left corner 
of GenomeBrowse. From here you can stream TSF 
annotation tracks from the cloud, add BAM fi les from your 
EA Pipeline account, or add example data. Data from the 
cloud can also be downloaded to your local computer.

  You can also do the same as above by right-clicking in 
empty space in either the Plot Tree or the Plot View and 
selecting the Add button.

  You can change the default visible plots for Read 
Alignment (BAM) fi les by opening the Options... dialog in 
the Tools menu or by clicking on the Gear icon in the tool 
bar (       ) and checking or unchecking the Coverage or 
Pile-up options.

  You can change where new plots are added in the 
Options dialog. By default new plots are added to the 
Top of the plot view, this can be changed to have plots 
added to the Bottom of the view.

How do I navigate?
  There are two navigation modes in GenomeBrowse:

  In Navigation Pointer Mode (            ), you can pan any 
plot or axis by holding down the left mouse button. 
Dragging with the right mouse button scales the 
plot.

  Zoom Mode (            ) will give you access to the 
rubber band zoom feature.

  You can use the scroll wheel to zoom in and out in any 
mode.

  By default, all plots have y-axis fi t-data or auto zoom 
enabled.  To change the y-axis zoom mode, hover over a 
plot and click the zoom mode button on the right edge 
(labeled with a letter). 

  You can jump to a specifi c region or gene by typing it 
into the Zoom Toolbar. This includes typing in a gene or 
transcript name. If there are multiple options, the fi rst 10 
results from each searchable track will be displayed in a 
drop down list.

  There is a zoom slider for the x-axis in the toolbar 
between the – and + buttons. These controls scale the 
x-axis on all plots.

  There are left and right arrows framing the Domain Scale. 
These controls pan the x-axis on all plots.

  Keyboard shortcuts:
  Arrow keys allow you to pan on the current plot. 
  + and - zoom in and out.
  Shift + scroll wheel lets you zoom on just the y-axis.

  Ctrl + Shift + scroll wheel lets you zoom on both  
axes.

  Double-click on the y-axis to zoom to y-extents.
  Double-click on the x-axis (or on a chromosome in 

the Domain View) to zoom to x-extents or the current 
chromosome.

  Right-click before you complete a zoom selection to 
cancel.

How do I see my previous view?
  Clicking the Back and Forward arrows (             ) allows you 

to traverse zoom history. 
  Right-clicking or holding the mouse button down on 

one of the buttons for a few seconds gives you a list of 
recent zoom history states, so that you can jump back by 
multiple steps.

  Keyboard shortcuts: Alt+left and Alt+right.

How do I change the species and/or genome build?
  You can choose a new build from the drop down menu in 

the Genome Toolbar.

How do I move and resize plots?
  You can drag plots around in the Plot View using their 

handles (at the left of a plot) or drag-and-drop nodes in 
the Plot Tree.

  To resize the plot, you can mouse over the handle (at the 
bottom of a plot) and drag up or down.

How do I change how my data is displayed in a plot?
  In some plots, a gear icon will appear in the top-left 

corner when view options are available. Click on this gear 
icon to view plot-type specifi c options.

  If the control panel is already open, you just need to 
select a plot to have the control options update with 
those relevant to that plot type.

  To open the control panel, right-click on a plot and 
choose Controls...

  In pile-up plots, you can choose to Emphasize Strand or 
Emphasize Mismatches and Stack Above Axis, Stack 

Split by Strand or Stack Paired-ends. Multi-mapped 
alignments can be fi ltered by clicking on Filter Multi-

Mapped Alignments. More controls are available by 
clicking on the More Controls... button. This brings up 
more display and fi ltering options.

  In a gene track, you can view regions in Compact or 
Expanded mode. Auto blends the two modes to adjust 
based on plot height.

  In variant maps, variant, interval and value plots, you can 
hide and show the Feature labels and change the label 
fi eld.

  Value plots have the additional feature of being able to 
change the Value displayed based on the values available 
from the source.



How do I edit plot labels?
  Double-click on any plot title or axis label to edit the text.
  Right-click on any plot title or axis label and select Edit...
  Right-click on a Plot Tree node and choose Edit Title.
  Double-click any Plot Tree node’s text.

How do I change the colors?
  Choose Options... in the Tools menu and click on the 

Color tab.
  Reference Mismatch defi nes the color of variant plots 

when zoomed out.

How do I delete a plot?
  Select the plot and press the delete key.
  Right-click on the plot in either the Plot Tree or the Plot 

View and choose Delete.

How do I change the Domain View (default is a cytoband)?
  Right-click on any plot in the Plot Tree or Plot View and 

choose Set As Domain View Plot.
  To change back to a cytoband, right-click on the Domain 

View and choose Restore Cytoband Plot.

What can I do with the mouse anchor?
  Right-click anywhere in a plot and choose Place Mouse 

Anchor to mark a location.
  Keyboard shortcuts: Ctrl+` to set, Alt+` to remove, and ` to 

center the view on it.

How do I save my project?
  By default, the project is saved on close. To disable this 

feature, open Options... dialog in the Tools menu and 
uncheck Save projects on close on the General tab.

  Similarly, the project settings are saved on close. To 
disable this feature, uncheck Save program settings on 

close in the Options dialog. 
  Click Save Program Settings Now to save 

GenomeBrowse in its current state.

How do I manage downloads from Public Data Sources?
  Once fi les are selected for download the Download 

window will open indicating progress of downloads. 
If GenomeBrowse is closed while fi les are being 
downloaded the Download manager will be minimized 
to the tray and downloads will continue.

  The Download manager can be accessed from the Tools 
menu.

How do I view a list of features or fi nd features in a sparse 

annotation track?
  If you hover over the upper-left corner of a plot view, a 

table icon will appear (       ). If you click on this icon the 
Feature List will open. By default up to 1000 features 
from the current zoom will be displayed. 

  You can jump to the start of the genome by clicking on 
the Start button, and then back to the current zoom by 
clicking on the Zoom button.

  Features can be sorted by clicking on the fi eld names 
(column headers). Once for ascending order, twice for 
descending order.

  Click on a feature to jump (zoom) to that feature in the 
plot view.

  Selected row(s) can be copied to the clipboard. Click on 
a row or use Ctrl+click or Ctrl+A to select multiple or all 
rows. Then right-click and select Copy Selected Row(s) 

to Clipboard or Copy Selected Row(s) with Headers. 
This table can then be pasted into a spreadsheet program 
or text fi le.

  A mouse anchor can be set at any of the features in the 
list by right clicking on a row and selecting Set Mouse-

Anchor At... 
  If there are more than 1000 features you can click on the 

Read More... link in the lower left corner to add more 
features to the list.

How do I create a new project, save or open a recent 

project?
  In the File menu there are options to create a new 

project, open a recent project, open a project by 
browsing the fi le system, save or save as a new project. 
When you create a new project you will be prompted to 
select the project genome assembly and to download the 
reference sequence if you do not already have it locally.

How do I know when there is an update available?
  There will be an Update Available message and a 

download icon (       ) in the lower-right corner of the 
GenomeBrowse window indicating that there is a newer 
version available. Click on the message to open the 
download page in a web browser to obtain the latest 
version. NOTE: This feature is only availalbe in version 1.06 
and later.

For more help, visit:
goldenhelix.com/GenomeBrowse/online_help

     



Mouse

Double-click on a title, scale, or node label to 
edit it in-place

Use the scroll wheel to zoom in or out
  On canvas—aff ects x-axis only unless 

auto-zoom is on or a modifi er key is used
  On scale—aff ects the scale axis only 

unless auto-zoom is on or a modifi er key 
is used

  
Double-click on the domain view or an x-axis 
scale:

  Zoom to target chromosome
  If already zoomed to a chromosome, 

zooms out to full data extents
  
Double-click on a y-axis scale to zoom to full 
data extents
  
Double-click on a plot feature to zoom to the 
feature extents

Pointer Navigation Mode

Left-drag to pan canvas or scale
Right-drag to stretch canvas or scale

Click the other mouse button to cancel a drag-
to-zoom operation in progress

Zoom Box Mode

Left-drag to zoom into selected area

Right-drag to zoom out, fi tting the previous 
view in the selected area

Click the other mouse button to cancel a drag-
to-zoom operation in progress

Zoom modifi ers remain restricted while y-axis 
auto-zoom is enabled. When both axes are 
enabled, dragging in a straight line aff ects only 
the axis parallel to the drag line.

Keys

Alt+[Key]  Menu access
Ctrl+J Show download window
Alt+Left  Previous view (back)
Alt+Right Next view (forward)

F1 GenomeBrowse Manual
F2          Edit title of current node 
 (Plot Tree)
Del Delete selected nodes 
 (Plot Tree or Plot View)
Ctrl+A  Select all 
 (Plot Tree or Plot View)
Ctrl+C Copy selected text 
 (Console or Plot Tree or Editor)
Ctrl+Z  Undo (in any text box)

Ctrl+N Create new project
Ctrl+O Open project
Ctrl+S Save project
Ctrl+Shift+S Save project as...
Ctrl+Shift+T Show/Hide Plot Tree
Ctrl+Shift+C Show/Hide Controls
Ctrl+Shift+O Show/Hide Console
Ctrl+Shift+F Show/Hide Feature List
Ctrl+Shift+N Show/Hide Note Editor
A or P Switch to pointer navigation 
 mode
Z Switch to zoom box mode

Q Set y-axis auto zoom mode on   
 selected plots
F or W Set y-axis fi t-data zoom mode on  
 selected plots
H or E  Set y-axis hold zoom mode on   
 selected plots
M or R Set y-axis manual zoom mode on  
 selected plots
F5 Reload selected plots

Arrow keys Pan current plot
+/- Zoom current plot 

Back tick (`) Jump to mouse anchor
Ctrl+' Place/move mouse anchor 
Alt+' Clear mouse anchor

Modifi ers
Click to select plot or Plot Tree node
Ctrl+ Multiple selection
Shift+ Select range between fi rst 
 selected and target
Ctrl+Mouse 
Wheel Scroll the plot view instead of   
 zooming

Zoom modifi ers remain restricted in some y-axis 
zoom modes

Zoom with mouse wheel or keyboard (+/-)
Shift+ Apply to opposite axis (e.g. y 
 instead of x over canvas)
Ctrl+Shift Apply to both axes (over 
 canvas only)
Right-hold Apply to both axes (scroll  
 wheel only over canvas)

Double-click domain view or x-axis scale
Shift+ Zoom to full data extents 
 regardless of current zoom

General Use

Left-drag to move a plot group by dragging its 
move handle (left side)

Left-drag to resize a plot by dragging its size 
handle (bottom edge)

Right-click on a specifi c target (such as the 
title) to get a list of relevant options

Left-drag on the funnel in the Domain Plot to 
pan the selection in the Plot View 

Left-drag on the edge of the funnel to resize it 

Left-drag outside of the current funnel to jump 
to new location 

Drag the zoom slider or use adjacent +/- 
buttons to zoom in/out on the x-axis

To change the y-axis zoom mode, hover over 
a plot and click the zoom mode button on the 
right edge (labeled with a letter).

Search Box/Location Bar

Click once to select all text in the search box

Double-click to select a portion of the search 
box value

With a cursor in the search box, triple-click to 
select all text

Type to replace selection with new 
chromosomes, coordinates, or feature name

  Zoom to a specifi c range by entering two 
end points

  Jump to a small surrounding area by 
entering one position

  Jump to a gene by typing in the gene 
name

While typing, the search box will search all 
tracks that are set as "searchable"

To set a track as searchable, right-click on it 
(Plot Tree or Plot VIew). Searchable data will 
show a “searchable” option. If checked, it is 
already searchable. If not, check it.

The link button to the right of the search box 
includes quick links to the current zoom for a 
few online genome browsers

The link button also includes a copy function 
for the current zoom in a format compatible 
with most genome browsers

Note: Use the Cmd key on Macs instead of Ctrl
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Zoom Toolbar

Genome ToolbarMode Toolbar

Menu

Plot Toolbar

Plot Tree 
Window

Console 
Window

Plot View

Domain View 
Domain Funnel
Domain Scale

Location Toolbar
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